
Barra de Ferramentas (BF)

(linhas superiores)
Ativas Notas (estão por ordem- cima x baixo, esq. X direito)

Barra de Projeto X Abrir, gravar, …

Barra de Navegação do Mapa X Começa com o icon da Mão, +, -, extender a todo o ecran, …

Barra de Atributos X
Informação, selecionar elementos, abrir tabela de atributos, medir comprimentos 

e áreas, …(começa com o icon i)

Barra de Gestão de Camadas X
Começa com Adicionar Camada Vetorial. 

É a Barra + imp.

Garmin MapSource X Gravar o projeto (ecran) com a extensão kmz (abrir n Google Earth)

Barra de Vetorial X Captura de coordenadas, Ferramentas GPS, ..

Set favourire CRS (quickcrs) X Escolha das coordenadas

Barra de Gestão de Fontes de 

Dados
X

Criar ficheiros temporários (criar linhas, polígonos, .,), Nova camada shapefile, ..

Começa com Abrir Gestor da Fontes de Dados (inclui o icon da "pena").

Barra de Digitalização X
Edições atuais, Editar os ficheiros (lápis amarelo), acrescentar pontos, …

Os ficheiros tem de ser shp

Barra de Base de Dados X
Gestor de base de dados (abre GeoPackage, Oracle Spacial, PostGIS, SpatiaLite e 

Camadas Virtuais.

Barra de Digitalização Avançada X É a que começa pelo icon da régua e esquadro

Barra de ajuda Ajuda, N-ao funciona.

Barra de atração Começa com uma ferradura, 

Barra de Digitalização de Forma

Barra de Etiquetas Introduzir etiquetas

Barra de Raster Georeferenciador, brilho das camadas, …

Barra de Web Começa com MetaSearch (meta pesquisa)

Barra de Módulos Começa com a consola Phyton. Inclui o Street View

Lat Lon Tools Toolbar

QuickOSM

SrtmDownloader

go2mapillary

GpxSegemtImporter GPX Segment Importer

ImportPhotos

QuickPrint



Shape Tools Toolbar
Começa com uma roda (permite criar figuras geométricas). 

Dá para medir comprimentos (régua curva),  

Barra Latitude Longitude Copy lat e lon (icon "duas folhas)



MENUS (1ª linha)



MENUS (1ª linha)



Processamento Ajuda

Ferramentas de processamento Conteúdos de ajuda

Graphical Modeler Documentação API

History Reportar um problema

Visualizador de resultados Necessita de suporte comercial ?

Página WEB do QGIS

Verificar versão do QGIS

Sobre

Patrocinadores do QGIS

MENUS (1ª linha)



Módulos

instalados
Icon

Texto

(BF)- Barra de ferramentas; Menus; 
Advanced Line 

Editor

Adds line editing tools (segment deletion, ...). This plugin adds functionality to enable faster line editing, esp. when working with 3D lines (preserving Z-

Coordinate). Labelling of lines with a "status"-Attribute is also possible.

AmigoCloud The AmigoCloud plugin allows to connect QGIS to AmigoCloud backend using AmigoCloud GDAL data source

Another DXF 

Importer / DXF2 

Shape Converter

Add DXF to QGIS , optional georeferencing, optional convert DXF to Shape. Features: - Other elements than the standard import are displayed - Display 

of text (Labeling) - Categorization by Layer - Group by Layer - Separate representation by layers possible - support (ESRI) World files for CAD datasets - 

support georeferencingAppend Features 

to Layer

Processing plugin-based provider that adds an algorithm for appending features to a vector layer

Algorithm to act as the 'Load' in an ETL operation, allowing you to store data into your target layer instead of into temporary layers

arrayPlus Functions to manipulate arrays and maps in field calculator. A plugin that add functions to manipulate arrays in field calculator (array_min, array_avg, 

array_majority, etc.). Also add support for hstore strings ("others_tags" field on .osm files).

Asistente 

LADM_COL  
Assistant to capture and manage data for Colombian multipurpose cadastre

Plugin de QGIS que ayuda a capturar y mantener datos conformes con LADM_COL y a generar archivos de intercambio de INTERLIS (.XTF).

Attribute painter Plugin for easy replication of attributes values between features. Attribute Painter usage:1) Click on "Pick source feature" and select a sample feature 

on map.2) On the table below will appears a selection list for attributes to be applied.3) Check the attributes to be copied.4) If necessary override 

source attributes values editing cells5) If necessary remap destination field between those available in field combobox6) Select destination features7) 

Click on "Apply to selection" to apply attributes to selected features"or6) Click on "Pick to Apply" to apply attributes to features one by oneotherwise 

8) Click "Reset source" to clear source selectionAttributes settings are now persistent changing between layers
Attribute 

Assignment

Easy to assign an attribute on QGIS

Austrian 

Elevation

Display elevation value of specified position on QGIS. Using Austrian Elevation Service by Manfred Egger (spatial resolution 10 x 10 m). Data Source: 

http://geoland.at

autoSaver (BF) Auto save current project and modified layers in edit mode at specified interval. The plugin provide a basic autosave functionality for project file 

and modified layers currently in edit mode. Currents edits can be saved as version files if layerVersion plugin is installed

Azimuth and 

Distance 

Calculator

Calculates azimuths and distances for a selected feature. The feature can be either a line or a polygon. The plugin also calculates Meridian 

Convergence and Kappa Factor for UTM projections to a given geographical coordinate. Azimuth and Distance Calculator Version 1.0.1 also generates:- 

Memorial descritivo- Memorial sintético- Selo da planta- Planilha de áreas e perímetros

Batch Hillshader Plugin to generate a three light exposure hillshade (shaded relief by combining three light exposures). This plugin generates a three light exposure 

hillshade (shaded relief by combining three light exposures) using as input LiDAR classified data (ASPRS classification / *.laz, *.las formats) or a Digital 

Terrain Model (DTM) in  raster format (GEOTiff / ASCII). The three light exposures combining method is based in Gantenbein (2012): 

<(http://pubs.usgs.gov/of/2012/1171/)> You can use LasPy Library to process LiDAR data (ASPRS las format) If you uses as input LiDAR data, note that 

plugin uses LASTools library and FUSION LDV. For more information see readme.md at plugin folder (see Installed version at the end)
Beeline Connect points along great circles

Creates a line vector layer that connects all input points along the shortest path on a spheroid



Bivariate legend This plugin helps creating bivariate legends

When you need to make bivariate legend, you don't want to create the legend yourself. Just use this plugin to produce it.

Buffer by 

Percentage 

Buffer polygon features so the buffered area is a specified percentage of the original area. Instead of buffering a polygon using a specified buffer 

distance, this plugin lets the user specify the area the buffered polygon should cover, as a percentage of the original polygon's area

CAIGOS PostgreSQL

Konnektor 
CAIGOS-GIS is a German-speaking product. Thats why the plugin is only available in German language. .Ab CAIGOS Version 2015 werden die 

Projektdaten in einer SQL-Datenbank gespeichert. Bevorzugte Umgebung ist dabei PostgreSQL mit PostGIS. Damit bietet sich die technische 

Möglichkeit die Geodaten ohne Konvertierung direkt in QGIS einzubinden. Der Schwerpunkt liegt dabei auf der Präsentation der Daten. Der große 

Vorteil der direkten Einbindung ist dabei die (fast) komplette Übernahme der Darstellung der einzelnen Ebenen. Dabei werden sowohl Punktsymbole, 

Ebenenprioritäten, Individualattribute als auch maßstabsabhängige Darstellungen übernommen. Selbstverständlich ist auch eine Übernahme von 

Fachschalendaten bzw. GISDB Tabellen möglich. Für die Darstellung in QGIS wird Projektstruktur mit Fachschalen/Themen/Gruppen und Ebenen 1:1 

übernommen. . Bedienung: Nach Einbinden des PlugIns sind die Funktionen unter dem Menüpunkt "Datenbank" --> "CAIGOS-Datenprovider" 

verfügbar.
Calculate 

Geometry

Calculate area, length, in arbitrary units, without typing expressions. This plugin calculates the area of the polygon and the length of the line, in 

arbitrary units. Compared to using field calculator, you don't need to type calculation expressions, so you can get results with fewer steps. Even if OTF 

is enabled, it doesn't affect the calculation result (see bug report #14675). Depois de editar a camada ao clicar com o botão direito (propriedades) 

aparece o “Calculate Geometry”

Captura de 

Coordenadas 

(BF, Vector) Capturar coordenadas do rato num SRC diferente

cartogram3 Generate anamorphic maps. This plugin creates continous cartograms (a.k.a. anamorphic maps) from polygon layers.It is a port of the QGIS 2.x 

cartogram plugin by Morten Wulff and Carson Farmer to QGIS 3, Python 3 and PyQt5. Features include parallel processing, the option to select 

multiple variables to batch-produce cartograms, and the possibility to use a maximum total error threshold as a stop condition.

CDAU 

Downloader 

Descarga de capas del Callejero Digital de Andalucía Unificado (España). La descarga se realiza mediante el servicio WFS de la Infraestructura de datos 

Espaciales de Andalucía (España). <a href='http://www.callejerodeandalucia.es/portal/web/cdau/'>Más información sobre el proyecto CDAU.  

</a></p><p>QGIS plugin for the download the layers of Callejero Digital de Andalucía Unificado (Spain). The download is performed through the WFS 

service of the Spatial Data Infrastructure of Andalusia (Spain). <a href='http://www.callejerodeandalucia.es/portal/web/cdau/'>More information 

about the CDAU project.</a></p>
Clipper This plugin lets you use clipping function in the same shapefile selecting a line or polygon as a clipping/cutting feature and then clips/splits all 

overlaying features Clipper plugin for Qgis 2.x/ 3.x 2014 © Giuseppe De Marco The clipper plugin is a python plugins that performs a missing feature of 

past and current (3.x ) Qgis Version: clipping of features inside the same shapefile from a selected feature (line or polygon). Polygon clipping from a 

selected polygon features clips all intersecting features and returns clipped

ClusterPoints Cluster Points conducts spatial clustering of points based on their mutual distance to each other. The user can select between the K-Means algorithm 

and (agglomerative) hierarchical clustering with several different link functions. Sometimes it is requisite to determine distinct groups of points on a 

map which are closest to each other. To automatize this process, Cluster Points allows you to find a predefined number of groups with mutually close 

points. <br><br>The cluster algorithms are well-known, but until now there has not been a comprehensive implementation for a GIS system, yet. This 

plugin was started during the project phase of a GIS-Analyst training course in Berlin (https://gis-trainer.de). In the first version, the output is a new 

shapefile with the original layer copied and a new field Cluster_ID added. The later versions are exclusively based on the processing toolbox and only 

add the new field Cluster_ID to the input layer.



Contour plugin (Vector, BF) Generate contours of set of data points. Generate contour lines (isolines) and/or filled contours of a field or expression on a point vector 

layer. Contours can be rendered with a ramp color. The contours are written to a memory (scratch) layer. If the MemoryLayerSaver plugin is installed 

these are saved with the QGIS project. Otherwise they can be saved to another persistant format. Requires python modules numpy, matplotlib.

CoordGuesser Unscrambles, parses and guesses coordinates. This plugin parses misstyped or scrambled coordinates from different projections to WGS84-Geo. For 

example, DMS and partial DMS (148 - 11' 7", 23 - 29' 24"), Commas instead of points (40°38'51,14", 40°38'50,67"), UTM without a zone and missing 

the leftmost digit (?90950,3431318.8)

Coordtransform Transform x,y input coordinate to whatever new reference system This plugin let the user transform x,y input coordinate to whatever new reference 

system using EPSG code number and even USER DEFINED crs. It also displays proj4 crs definition strings for the input and output crs along with the new 

x,y coordinate. This plugin let the user take advantage of QgsCoordinateReferenceSystem Class functionalities and allows the user to have a conversion 

software like CartLab inside Qgis. It is very useful when dealing with georeferencing tasks to check one point coordinates in a different CRS or simply 

when the user would like to know a point's coordinates in a different CRS. It extends the functionalities of the custom CS dialog letting the user convert 

coordinates from whatever CRS to whatever CRS.
CZML Generator Creates CZML files for Cesium.js. Creates CZML files for Cesium.jsfor thematic visualizations

D3 Data 

Visualization 

D3 Date and Time Heatmap. This plugin creates a D3 circular histogram heatmap from date and time fields in the data. It outputs an interactive web 

page.

Data Analysis and 

Visualization 

Calculate and show statistical properties for a field. Data Explorer is aimed at plotting and/or analysing data series, with particular emphasis on time 

series. The plugin structure has been partially inspired by the plugin

Data Plotly D3 Plots for QGIS

Draw D3 plots in QGIS

DB Manager Manage your databases within Qgis

Digitizing Tools Subsumes different tools useful during digitizing sessions. DigitizingTools is meant to be a compilation of tools missing in basic QGIS, especially when 

digitizing on existing features. It is a collaborative effort and does not contain CAD like functions meant for construction.

Discovery Provides search / gazetteer functionality in QGIS using PostGIS-based data. The Discovery plugin adds search capability to QGIS. Its key features are:- 

Connects directly to PostgreSQL / PostGIS (no reliance on web services)- Auto-completion of results- Flexible expression-based support for scales- Can 

use multiple fields to display result context Simple GUI-based configuration

DWA M150 XML 

Import

Import Lines and Points (Manholes and sewers) from DWA XML 150

dzetsaka : 

Classification tool 

Fast and Easy Classification plugin for Qgis. Plugin for semi-automatic classification with Gaussian Mixture Model, Random Forest*, and SVM* 

classifiers.Very easy and fast to use.*You need to install scitkit-learn library to use these algorithms.For more information on this tool check our github 

: https://github.com/lennepkade/dzetsaka/



EasyCustomLabeli

ng

Allows to quickly duplicate layer into memory layer ready for data defined labeling. Requires Memory layer Saver >= 3.2 to restore all labels correctly 

EasyCustomLabeling is a plugin for QGIS, designed to simplify the work for manual and data defined labeling. The tool duplicates a data vector layer 

into a new memory layer made of lines, adds all necessary fields for advanced custom labeling like label location, rotation, color, font, callout, 

alignements. The resulting layer is activated ready to use labeling tools. Data is saved in Memory Layer provider, which means it is NOT saved to a file 

or a database. To make thoses layers persistent, please install Memory Layer Saver v3.2 or higher plugin, that saves all memory layers to a 

qdatastream file along the project named myqgisprojectname.qgs.mldata.
Edição Sem Rede Permite a edição sem rede e sincroniza com a base de dados

EO Time Series 

Viewer 

Visualization of multi-sensor Earth observation time series data. Highlights<ul><li>Spatially synchronized maps for each observation 

date</li><li>Multiple band combinations in parallel, e.g. True Color <i>and</i> SWIR bands</li><li>Multi-sensor support: separate render settings for 

separate senors/image products</li><li>Visualization of Spectral and Temporal Profiles</li></ul>Usage<ol> <li>"Files" > "Add images" to define the 

time series</li> <li>"View" > "Add Map View" to create a new row of maps, e.g. for SWIR visualization</li> <li>For each map view specifiy how each 

sensor should be rendered, e.g. RGB or single band color range</li> <li>Optimize render settings, e.g. via map canvas context 

menu</li></ol>Dependencies<ul> <li>pyqtgraph (required)</li> <li>PyOpenGL (optional)</li></ul><p> Install depencencies with <code>python -m pip 

pyqtgraph</code></p>
eVis (Base de Dados) Uma ferramenta de visualização de eventos - ver imagens associadas com elementos vectoriais

FastVersion Allows data versioning for PostGis tables, permission and project management. System Administrator.

PostGis data versioning, permission and project management. System Administrator.

Ferramentas GPS (Vector, BF) Ferramentas para carregar e importar dados GPS

First Aid The must-have tool for Python plugin developers. Provides Python debugger and replaces the default Python error handling in QGIS with a more 

sophisticated handler that allows more thorough inspection or the Python error: browse the frames, view variables, see source code or even execute 

Python code within the context of the error.

Flickr Metadata 

Downloader 

This plugin helps downloading metadata of geotagged Flickr photos. This plugin helps downloading metadata of geotagged public Flickr photos of 

within a given geographic quadrangle.Metadata includes geographic position, user ID, date, tags and the URL of a small thumbnail image as well.The 

downloaded data is stored in a Spatialite database file.A free Flickr API key is required to use this plugin

Freehand raster 

georeferencer 

Interactive georeferencing of rasters

Tools to georeference a raster interactively (move, rotate, scale, export...) 

FS3 (Vector) Quickly generate, display, and compare basic statistics and graphs for numeric and text fields of vector layer(s). This plugin was created by 

Orden Aitchedji, McKenna Duzac, Andreas Foulk and Tanner Lee during the 2018 summer field section at the Colorado School Of Mines in 

collaboration with Brian Krzys at Newmont Exploration.

GeoCoding GeoCoding and reverse GeoCoding using Nominatim and Google web services. This plugin allows the user to search for an address and get its 

coordinates (geocoding) using GeoCoding using Nominatim and Google web services. It also allows to get the address of a point by clicking on the map 

canvas (reverse geocoding).



GeoDataFarm (BF) This is a plugin for farmers that aims to determine impact of different parameters to the harvest yield. This is a plugin that aims to determine the 

yield impact of different parameters. It is built for any crops and any other field parameter. The program requieres that matplotlib is installed with 

osgeo4w network installation, to use the plugin requires an internet connection all data is going inserted will be saved locally in a shapefile and on 

GeoDataFarms server. This is to increase the speed of the analyses. For all questions and request for modifications etc. please contact: 

geodatafarm@gmail.com

Geodesic 

Densifier 

(BF) Adds vertices to geometry along geodesic lines

Geomapfish 

Locator  

A locator filter for Geomapfish services

Allows to search in Geomapfish instances. Connection is also possible for private searches.

Geoportal LU Use services from the luxembourgish Geoportal in QGIS

Use services like the location search and - later - WMS service from the luxembourgish Geoportal in QGIS

Georreferenciado

r GDAL 

Georreferenciar imagens usando GDAL (Geospatial Data Abstraction Library)

Geosearch DK Search and zoom to named places in Denmark. Uses Kortforsyningen services for searching Danish addresses, road names, place names, land registry 

and a lot more. In order to use the plugin, a user at Kortforsyningen is required. If you do not have a Kortforsyning-user, create one with this <a 

href="http://download.kortforsyningen.dk/ /content/opret-mig-som-bruger">link</a> - it is free of charge. When the plugin is installed, enter your 

user name and password to Kortforsyning in the dialog found under the menu Plugins --> Geosearch DK --> Settings. This plugin is developed by 

Septima.
GeoTrace Collection of tools extracting trace data from commonly used geoscience rasters such as imagery, topography and geophysics. GeoTrace is a QGIS 

plugin containing some helpful tools for extracting and analysing the orientations of geological structures. It can be used to rapidly digitize structural 

traces in raster data, estimate their 3D orientations using an associated DEM, and then visualise the results on stereonets and rose diagrams. There is a 

complementary plugin, Compass, for CloudCompare that provides similar functionalities for 3D point clouds. The trace extraction method (Trace tab) 

uses a least-cost path algorithm to "follow" linear features in the raster. This relies on a single-channel cost raster in which the structures of interest 

are represented by low values, and the background by high values. A variety of functions for quickly calculating such a cost function have been 

included in the Cost Calculator tab. See the about tab for more information and a quick guide on how to use the plugin

Get WKT This plugin displays the selected features' WKT representation. It differs from QGIS's Core copy functionality by only extracting the features WKT, 

rather than the entire record. Simply select a feature, press the button and the WKT represenation will be displayed in a dialog box where you can 

copy its content for use in creating or updating geometries in SQL statements. Based on the original version for QGIS 2 by Hugo Ledoux at 

https://github.com/hugoledoux/QGIS-getWKT

go2mapillary (BF) Mapillary explorer

Explore Mapillary street level imagery on QGIS3: http://www.mapillary.com

go2streetview (BF) The plugin allows to get a window with Google Street View or Bing Bird's Eye clicking and dragging the cursor on map to set location and direction 

of the desired view. Go2streetview allows to get a window with Google Street View or Bing Bird's Eye clicking and dragging the cursor on map to set 

location and direction of the desired view. Features: Automatic SRS conversion, Transparent proxying, View position on map, Take Snapshots of 

current view, Dockable Dialog Windows, Overlay info layer support, Map follows Streetview, Streetview service coverage



GPX Segment 

Importer 

This plugin imports an GPX file and creates short line segments between the track points. Features include:* Select one or multiple GPX files with the 

same data structure at once and create short line segments between the track points.* Read all attributes available from each track point at the 

segment start and/or end. This includes the timestamp and the elevation as well as any other attributes added to a track point.* To gain full control 

over the data, you can edit the attribute table before creating the segment layer. The user can select the attributes that should be included in the 

layer, modify the attribute label and change the data type (integer, double, boolean or string) if the automatic type detection failed, e.g. at numeric 

data that contains “Null” or “None” values.* The plugin detects attributes that do not have a value and deselects it. Values can still be selected 

manually.* Optionally use an alternative coordinate reference system (default is EPSG:4326).* Optionally calculate motion attributes (distance, speed 

and duration) between track points.* Create a temporary memory layer or write the layer to a GeoPackage.* Update v2.1: Importer additionally 

available as QGIS algorithm for usage in processing
HCMGIS HCMGIS - Geometry Processing and Field Calculation Utilities. HCMGIS is a set of useful geometry processing and field calculation utilities: - Basemap: 

Add global basemap from OSM Stamen, Carto, Google, HCMGIS Aerial Images,... - HCMGIS OpenData: Download free and open geodata from 

http://opendata.hcmgis.vn - Spatial Processing: + Create Skeleton/Medial Axis/ Centerline for road/ river networks and similar linear structures + 

Create Centerline in Polygon's gaps (E.g building blocks) + Finding closest/ farthest pair of Points in a Point set based on Voronoi Diagram + Merge 

layers (with the same attributes and geometry type), split Layer (based on unique field), geometric error checking, geometric correction, CRS 

transformation (VN2000 <--> WGS84,...). - Attribute Calculation: merge/ split data fields, add prefix/ suffix, find & replace. Especially the Vietnamese 

Font Converter: Unicode <-> TCVN3 <-> Vni-Windows, UPPER CASE, lower case,...
Highlighter Highlight selected features. Highlight selected point or line features with a thick dot or line coloured in a user-defined colour. The layer whose features 

should be highlighted has to be defined in settings.

Hotlink Triggers actions on single click to facilitate the use of actions attached to vector layers

When the plugin is activated (button in the toolbar), the objects "carriers" of actions become "clickable".

Hotspot Analysis This plugin implements LISA statistics needed for Hotspot and Cluster Analysis. The Plugin implements Local Indicators of Spatial Association (LISA) 

statistics to perform the Hotspot (Getis-Ord Gi*) and Clusters (Moran's I) analysis and links them to maps. Input data must be a shapefile of points or 

polygons with an associated projected coordinate system and (at least) one numeric attribute. The plugin requires Pysal (see repository for installation 

instruction).

HTP 

Geoprocessor 

Geospatial tool for geoprocessing HTP sensor data Geospatial tool for geoprocessing high-throughput phenotyping sensor data

ICSM NTv2 

Transformer 

This plugin uses official ICSM grids to transform between Australian coordinate systems.

This plugin enables accurate transformations using official Australian NTv2 grids

IDECanarias The plugin allows you to search all locations of Canary Islands.

The plugin allows you to search all locations of Canary Islands, Spain

ImportEpanetInp

Files

IMPORT/EXPORT EPANET INP Files. This tool can be used to IMPORT EPANET INP File to shapefiles and adds them in the QGIS canvas. Also, the 

shapefiles stored into the _shapefiles_ folder. Can be used to EXPORT EPANET INP File.

Import Photos (BF) This tool can be used to import Geo-Tagged photos (jpg or jpeg) as points to QGIS. The user is able to select a folder with photos and only the geo-

tagged photos will be taken. Then a geoJSON point file will be created which will contain the name of the picture, its directory, the date and time 

taken, altitude, longitude, latitude, azimuth, north and camera maker and model. The plug-in doesn’t need any third party applications to work. It has 

two buttons; the one is to import geotagged photos, and the other one is to be able to click on a point and display the photo along with information 

regarding the date time and altitude. Mac users please refer to the Read Me file for further guidance.



Indicatrix mapper The plugin introduces the tiss-indicatrix (quick-and-dirty Tissot-indicatrix realization) term by Szabó and Wirth, 2015. The tiss-indicatrix uses constant 

radius ellipsoidal caps (calculated by Vincenty's formula) instead of the original infinitesimal small Tissot circles. These caps are able to transform on 

the fly from a reference ellipsoid to a selected project coordinate reference system. The user can study the distortions of the caps in a blink, such 

conclusions can be drawn as the projection is conformal or equal-area. The extent and resolution of the caps and the graticule are able to define. The 

segments refers to the preciseness of the geometrical elements. The radius parameter means the magnitude of projecting caps, it can be given in 

kilometer or degree dimension. In case of adding more layers untick the 'Simplify geometry' option at the Rendering tab of layer properties. QGIS 

contains approximately 2700 categorized projections, you can test the effects of the projections for your Country as well. Check the homepage or look 

after 'QGIS Map Projections' tutorial video by BME FMT on YouTube for further detail.

Inspire 

Flurstuecke 

Sachsen und 

Thüringen 

Download, display and conversion of the Inspire parcels for the German states of Thuringia and Saxony. Remark: The plugin worked only data from 

Germany (Saxony, Thuringia). Thatswhy the plugin is only available in German language. - Download der Inspire Daten für Sachsen und Thüringen - 

Darstellung Flurstücke und Flurstücksnummern - Optionale Abspeicherung als Shape + Darstellung - Optionaler Export nach DXF Bedienung:  Nach 

Einbinden des PlugIns sind die Funktionen unter dem Menüpunkt "Web" --> "Inspire Flurstuecke" verfügbar.

Instant Print Instantly print map excerpts

The instant print plugin allows to quickly print map excerpts to a file, utilizing an existing composer as page layout.

Interlis Interlis Import/Export

IPyConsole This plugin adds a Python console based on IPython.IPython has full introspection support and TAB completion, syntax highlight, online help ad a lot of 

cool features you will love! Optionally, this plugin creates more "pythonic" interface to Qgs classmethods for an easier introspection and TAB 

completion of Qgs classes. Note: you must separately install IPython and IPython Qt console to use this plugin. On a Debian-like distributions this is as 

easy as running "pip install 'ipython[all]==3.1.0 qtconsole' or (better) "pip install jupyter==1.0.0 qtconsole". To install packages with 'pip' you may need 

root/admin privileges.

JapanElevation Display elevation value of specified position on QGIS. Using Elevation API by Geospatial Information Authority of Japan.

Join multiple 

lines 

Permanently join multiple lines. After selecting multiple features of a line layer, this plugin can merge them into one feature with a continuous line.The 

plugin will automatically put the selected lines in a geographically logical order and direction. If the end points of two lines do not match exactly, a line 

segment between both points is added to make the end result a single, continuous line. The attributes of the new line will be those of one of the 

selected features, but one cannot predict which one.

Karika Terrain generalization. Terrain generalization by line integral convolution of the elevation values along the surface gradient, as described in the PhD 

thesis "Automatic Swiss style rock depiction" (https://doi.org/10.3929/ethz-b-000201368).



Kortforsyningen Easy access to webservices from Kortforsyningen (The Danish Map Supply) in QGIS Desktop. This plugin makes it easy to use webservices from the 

Danish Map Supply (In Danish 'Kortforsyningen').<p></p>When installed, a new menu is added to QGIS. This menu contains webservices (WMS and 

WFS) categorized by themes. In order to use the plugin, a user at Kortforsyningen is required. If you do not have a Kortforsyning-user, please create <a 

href="http://download.kortforsyningen.dk //content/opret-mig-som-bruger" target="_blank"> one</a> - it is free of charge. Enter your username and 

password in QGIS' option-dialog (found in QGIS' setting-menu) (a new thing in QGIS3!). It is possible to add your own layers and services to the 

Kortforsyning-menu. Read more about this <a ref="https://apps2.kortforsyningen.dk/qgis_knap_config/ QGIS3/About/qgis3about.html#en" 

target="_blank"> option</a> (link opens in your browser).<p></p>In danish:<p></p>Dette plugin gør det let at bruge webservices fra 

Kortforsyningen.<p></p>Når pluginet er installeret, tilføjes en ny menu, Kortforsyningen, til QGIS. Denne menu indeholder webservices (WMS og WFS) 

kategoriseret i temaer. For at bruge dette plugin, er det nødvendigt at have en bruger til Kortforsyningen. Hvis du ikke allerede har en bruger, oprettes 

denne <a href="http://download.kortforsyningen.dk//content/opret-mig-som-bruger" target="_blank">her</a> - det er gratis. Indtast dit brugernavn 

og kodeord i QGIS' indstillingsdialog (findes i QGIS indstillingsmenu) (nyt i QGIS3!). Det er desuden muligt at tilføje dine egne lag og services til 

Kortforsyning-menuen. Læs mere om denne <a href="https://apps2.kortforsyningen.dk/qgis_knap_config /QGIS3/About/qgis3about.html#da" 

target="_blank"> mulighed</a> (linket åbnes i din browser).<p></p>This plugin is developed by <a href="www.kortforsyningen.dk" target="_blank"> 

Kortforsyningen (Styrelsen for Dataforsyning og Effektivisering)</a> and <a href="septima.dk" targer="_blank">Septima</a>.<p></p>Contact 

information: kortforsyningen@gmail.com<p></p><img src="https://www.kortforsyningen.dk/sites/default/files/sdfe_logo.png" 

alt="SDFE"><p></p><img src="http://www.septima.dk/skin1/img/logo_143x39.png" alt="Septima">

LandXml import 

plugin

Import parcels and nodes from a LINZ LandXml file. The LandXml format is an Xml format used to transfer cadastral survey data.The format can 

describe cadastral survey parcels, nodes, and observations.This plugin is used to extract information from a LandXml data file intomemory layers in the 

QGIS plugin. Currently it supports parcels andnodes, and observations.The plugin is designed to work with LandXml files generated by theLand 

Information New Zealand Landonline application - it may not supportLandXml from other sources.

Lat Lon Tools (BF) Tools to capture and zoom to coordinates using decimal, DMS, WKT, GeoJSON, and MGRS notation. Provides external map support, MGRS 

conversion and point digitizing tools. Lat Lon Tools makes it easy to capture, zoom to coordinates, and interact with other on-line mapping tools. It 

adds MGRS support to QGIS. When working with Google Earth, Google Maps or other on-line mapping tools, coordinates are specified in the order of 

'Latitude, Longitude'. By default Lat Lon Tools uses the standard Google Map format, but is very flexible and can use virtually any projection and 

coordinate format for input and output. The plugin has the following tools. 1) Capture coordinates to the clipboard (in any projection) when the user 

clicks on the map. 2) Zoom to and highlight a point on the map using coordinates from any projection, including MGRS, and can format the coordinates 

in decimal, DMS, WKT POINT, or GeoJSON notation. 3) Digitizing service to add points to a layer. It supports all the "Zoom to" input formats.4) Launch 

and display an external map based on the coordinate clicked on.5) Use a list of points for rapid zooming created from a file, direct input, or captured 

from the map. Create a point layer from these locations.6) MGRS conversion routines that converts a layer with an MGRS field into a point layer, and 

creates an MGRS field from the point layer.7) Routines to convert a point layer geometry into a textual representation of that geometry within a 

field.Lat Lon Tools makes it possible to seamlessly copy and paste between QGIS, Google Earth, and other on-line maps. The user can specify the 

delimiter used between coordinates and whether the coordinate order is 'Latitude, Longitude (Y,X)' or 'Longitude, Latitude (X,Y)'.
Layer From 

Clipboard 

Create layer from clipboard data. Layer from clipboard is a plugin that allows users to create a memory layer with the clipboard data. The data can be a 

delimited text, html table or a spreadsheet.

Layers menu 

from project 

Build layers shortcuts menus based on QGis projects

Allow easy opening of layers maintaining their style.

Line direction 

histogram 

Create a histogram (rose diagram) of line directions. Visualises the distribution of line segment directions as a rose diagram (weighted using the line 

segment lengths). Can save the rose diagram as CSV, PDF or SVG.



Linear Theory 

Orographic 

Precipitation 

Implements the Smith & Barstad (2004) LT model. This plugin implements the Linear Theory of Orographic Precipitation model by Smith and Barstad 

(2004). The model includes airflow dynamics, condensed water advection, and downslope evaporation. Vertically integrated steady-state governing 

equations for condensed water are solved using Fourier transform techniques. The precipitation field is computed quickly by multiplying the terrain 

transform by a wavenumber-dependent transfer function. The code is fast even for larger rasters if sufficient RAM is available. However, processing 

large rasters with insuffiecient RAM is very slow. Before using this plugin, please read the original manuscript of Smith and Barstad (2004) to 

understand the model physics and its limitations.
LM Open Data 

WMTS 

Swedish National Land Survey Open WMTS layers. This plugin makes it easy to add <b>Swedish National Land Survey</b> WMTS layers to your QGIS 

project. You will need a National Land Survey <i>"token"</i> key which you can get at <a href="https://opendata.lantmateriet.se/#register">https:// 

opendata.lantmateriet.se/#register</a> .<br><br>Map layers are Open Source Licensed with <i>CC 0</i> (<a href="http://www.lantmateriet.se 

/sv/Kartor-och-geografisk-information/Kartor/oppna-data/villkor/">License</a>).<br><br>The National Land Survey do <u>not</u> support this 

plugin!

Load QSS - UI 

themes 

Configure look and feel for Qgis. <b>Load QSS allows the user to load his/her own *.qss files and change the look and feel of Qgis.</b><BR /> Some 

examples o predefined themes are provided. <div style="width:400px; height:200px;overflow:scroll; overflow-x: hidden; overflow-y: hidden;"> <img 

src="https://goo.gl/GgTCxc" width="300" height="200!important"/> </div> <a href="https://all4gis.github.io//">Author website</a>

Locate points 

along lines 

Creating points along lines

Creating points along lines with given offset and interval

LRS Linear reference system builder and editor

The plugin supports calibration, creation of punctual and linear events and calculation of measures for points

Mascaret Pre and Post-processing for Mascaret. Plugin dedicated to the building and exploitation of Mascaret models. Requires PostgreSQL and PostGIS. Based 

on an initial version developped by Matthieu NICOLAS (SPC Maine Loire aval) Some parts are based on the RiverGIS plugin developped by Radek Pasiok 

& Lukasz Debek (Many thanks for the work they've done on RiverGis)

Mask Help to create mask, filter labels in it. This plugin allows user to quickly transform a polygon selection into a map masking layer or a region of interest, 

following symbology choice. The plugin allows also to spatially filter labeling of other layer, so that labels will only appear in the Region of Interest.

Memory Layer 

Saver 

Makes layers with memory data providers persistent. Makes layers with memory data providers persistent so that they are restored when a project is 

closed and reopened. The memory provider data is saved in a portable binary format (QDataStream) that is saved with extension .mldata alongside the 

project file.

Menu Builder Create your own menus with your favorite layers. Create your own menus with your favorite layers. Easy configuration is done with drag & drop from 

the qgis browser.

MetaSearch 

Catalog Client 

(BF) MetaSearch is a QGIS plugin to interact with metadata catalog services (CSW). MetaSearch is a QGIS plugin to interact with metadata catalog 

services, supporting the OGC Catalog Service for the Web (CSW) standard. MetaSearch provides an easy and intuitive approach and user-friendly 

interface to searching metadata catalogs within QGIS.

mmqgis A collection of QGIS vector layer operation plugins. MMQGIS is a set of Python plugins for manipulating vector map layers in Quantum GIS: CSV 

input/output/join, geocoding, geometry conversion, buffering, hub analysis, simplification, column modification, and simple animation. MMQGIS 

provides an alternative to the Processing toolbox, with verbose progress reporting, an intuitive user interface, direct shapefile/CSV-file access, and 

some additional capabilities missing from other plugin sets.



Multi Ring Buffer Create multiple fixed distance buffer rings around a feature/set of features. Creates "doughnut" ring buffers, not including the buffered feature, or 

regular buffers. Create multiple buffer rings around a features/set of features. Creates "doughnut" ring buffers, not including the buffered feature, or 

regular buffers which do. Works in a sequential manner by buffering the resulting buffer and differencing the previous buffer. Also by default the 

buffer dissolves the features before buffering. Dissolving makes adjacent features behave in a better manner without overlapping buffers. The QGIS 

buffer feature has the logic behind this. Supports buffer distance entry using comma seperated value string, negative values not supported. Thanks to 

Neil Benny and Matt Walsh. Help: https://rawgit.com/ HeikkiVesanto/QGIS_Multi_Ring_Buffer /master/help/index.html

Multi-distance 

buffer 

Create multiple distance buffers. The Multi-Distance Buffer plugin creates a multi-distance buffer vector layer from an input vector layer and a set of 

distances. The result layer consists of bands (donut type) of regions according to the buffer distances provided. If 100 and 200 are provided as 

distances, the result layer will consist of two bands - one will contain all areas that are within 100 units from the geometries of the input vector layer, 

the other will contain all areas that are from 100 to 200 units from the geometries of the input vector layer. The user can choose to only buffer around 

selected features. Negative buffer distances are allowed for polygon layers.

Multipart Split Split selected multipart features during edit session. The plugins adds a "Splits feature(s) parts" item to the Edit menu, and a similar button in the 

Advanced digitizing toolbar. The buttons are only enabled when the current layer is in edit mode and has features selected.

Mutant Display values from loaded raster layers in a table or plot optionally ordered by time which can be extracted from the layername (or other sources). 

Display raster layer values at current mouse position ordered by time. Time can be extracted on the fly from Layer(File)name or other sources. Used 

Layers can easily be selected by using expressions.

MySQL Importer Import spatial and table data into MySQL/MariaDB. This plugin uses ogr2ogr to import spatial and table data into MySQL and MariaDB. Please make 

sure you have the MySQL Python extensions installed! (The plugin will give an error message if these are not installed). For Windows users the 

"Unofficial Windows Binaries for Python Extension Packages" can be downloaded at http://www.lfd.uci.edu/~gohlke/pythonlibs. These .whl 

compressed python extensions can then be extracted (you may need 7-Zip for that) to your <Python installation>\Lib\site-packages folder, or installed 

with the "pip" installer, to allow MySQL/Python interaction. For Linux and Mac installations please read your operating system instructions on how to 

install the MySQL/Python extensions.
NatusferaQGIS 3 Harvest biodiversity observations from Natusfera. NatusferaQGIS harvests data from Natusfera, a Citizen Science platform for biodiversity 

observations (http://natusfera.gbif.es). The plugin lets the user choose downloading data of a given user, a project, a taxon, or the whole dataset. Data 

are downloaded as a .csv file with several attributes, including location, taxonomic name, taxonomic group, date and time of observation. The file is 

saved in a folder chosen by the user when the download starts. This plugin has been developed thanks to the funding of FECyT and Obra Social La 

Caixa.

NNJoin Nearest neighbour join. Join vector layers based on nearest neighbour relationships. The NNPlugin joins two vector layers (the input and the join layer) 

based on nearest neighbour relationships. All geometry type combinations are supported. A feature from the input layer is joined to the nearest 

feature in the join layer. The result of the join is a new vector layer with the same geometry type and coordinate reference system as the input layer. 

Joining layers with different Coordinate Reference Systems (CRS) is supported, as long as the join layer coordinate system is a projected CRS. The join 

and distance calculations is performed using the join layer CRS. Self joins are supported. For self joins, each feature in the layer is joined to its nearest 

neighbour within the layer. A spatial index (QgsSpatialIndex) on the join layer is used to speed up the join for layers with non-multi-geometry types.

Nominatim 

Locator Filter 

This is a plugin which adds a Nominatim Locator Filter to QGIS. Nominatim is a free Geocoder service provided by the OpenStreetMap project.A 

Locator Filter implements the fetching of data from internal or external sources.Because it is *NOT* allowed to use the Nominatim service as a 'search 

as you type' service,the locator will not fire a request unless you end your string with a space or enter.Read more: <a 

href="http://www.qgis.nl/2018/05/16/english-coding-a-qgslocator-plugin/?lang=en">http://www.qgis.nl/2018/05/16/english-coding-a-qgslocator-

plugin</a>



norGIS ALKIS-

Einbindung

This plugin is dealing with German cadastre data (therefore not localized). QGIS-Erweiterung zur ALKIS-EinbindungFunktion:* Einbinden von durch 

norGIS ALKIS-Import vorbereitete Datenbanken.* Einbinden in QGIS* Export von UMN-Mapfiles (optional, erfordert python-mapscript)* Signaturierung 

nach GeoInfoDok* Eigentümerabfrage (Einzelabfragen)* Client für norGIS Liegenschaftsbuch

OSM place search Location search helper. Based on OSM (Open Street Map) data, Nominatim online tool (http://wiki.openstreetmap.org/wiki/Nominatim_usage_policy)

OSM Tools Open route service routing, isochrones and matrix calculations for QGIS. OSM Tools provides access to most of the functions of openrouteservice.org, 

based on OpenStreetMap. The tool set includes routing, isochrones and matrix calculations, either interactive in the map canvas or from point files. 

Extensive attributes are set for output files, incl. duration, length and start/end locations.

OSMDownloader Plugin to download OSM data by area, using a selection by rectangle. The plugin can also automatically load the osm file into QGIS in a transparent 

way. Plugin to download OSM data using threads with a simple area selection.It can automatically load downloaded *.osm files as QGIS layers.

Parallel Line 

Construction 

This plugin constructs parallel lines based on a given baseline. It is comparable to an offset line in cad programs / tools, but can construct more than on 

line.

PDOK 

Locatieserver 

Locator Filter 

This is a plugin which adds a PDOK Locatieserver (dutch geocoder) to QGIS. PDOK Locatieserver is a free Geocoder service provided by PDOK, The 

Netherlands.A Locator Filter implements the fetching of data from internal or external sources.PDOK Locatieserver is both a suggest service and an 

info service

PDOK services 

plugin 

Plugin to easily load the available dutch PDOK (Publieke Dienstverlening Op de Kaart) services. Currently only in dutch.

pgChainage Plugin for chainage linestrings of a table directly in PostgreSQL/PostGIS. This plugin converts a layer of line strings into a chain of points. The main work 

takes place directly in the PostgreSQL-/PostGIS-database, i.e. big tables have not to be imported into QGIS before and during processing.Usage: Fill in 

the parameters for establishing a connection to the database. The DBMS has to be PostgreSQL, and the extension PostGIS must created before starting 

the processing. Press the "connect to database"-button. A Message Bar above the map window will appear and tells the user, whether a connection 

could established or not.Choose the table (and schema), which should be used for the chainage. The table must have a geometry column of the type 

LINESTRING. Then fill in the other fields. The CRS can differ from the CRS of the choosed geometry. The PlugIn calls the PostGIS-function ST 

Transform(...) to project the geometries into the specified CRS; to state the CRS of the geometry-column is not necessary. It is recommended to specify 

a metric CRS. If the checkbox "calculate last point/last substring of lines" is checked, the endpoint and/or the last substring of each line will be 

calculated by ignoring the specified equidistance (just for the end-geometries) and inserted into the database.Their are three buttons to start the 

processing. The button "create points" just creates points along each line. The button "create substrings" just creates lines with the same specified 

distance from the input layer. The button "create points & substrings" starts both processings.Important: The plugin has been developed and tested 

using PostgreSQL 10 and PostGIS 2.4. Maybe it will not work with older versions of the named products, e.g. the chainage is realized by using the 

PostGIS-function ST_LineInterpolatePoint, which has the name ST_line_interpolate_point e.g. in PostGIS 2.1.ource of the icon: Webalys - Kameleon 

Icons (http://www.kameleon.pics)
Physiocap3 This plugin helps analysing raw data from Physiocap inside QGIS3. This is a plugin dedicaded to Physiocap users "Agronomist of the vine". This version 

is available in French, Italian & English but documentation exists only in French. Cette extension aide à l'analyse des données brutes de Physiocap sans 

quitter QGIS3. Il est dédié aux utilisateurs de Physiocap "Agronome de la vigne". Physiocap est un capteur qui géolocalise les sarments d'une 

vigne.L'extension (plugin) Physiocap n'intéresse que le métier "Agronomie de la vigne".Physiocap est breveté par le CIVC.



pickLayer pick to feature on map canvas to perform layer and feature commands. The plugin allows to perform layer and features operations by a contextual 

menu clicking over features on map canvas. This is useful when many layers are loaded in the project and is difficult to find them in a crowded legend.

Place Marker Place Marker provides a convenient way of adding placemarks to a vector layer. Place Marker provides a quick and easy way of creating point layers 

and adding features with preset attributes. Unlike using the built-in editing tools, the created layer contains the necessary attributes, and newly added 

features are committed directly to the data store and should be available immediately on other QGIS instances. It addresses to usage scenarios where 

QGIS in conjunction with the "PosiView" plugin serves as an online visualization and navigation tool, e.g for scientific subsea surveys with remotely 

operated or autonomous vehicles. It allows marking and sharing interesting places and events during the dive.

Plugin Builder 3 Creates a QGIS plugin template for use as a starting point in plugin development Create a template for a QGIS plugin

Plugin Load Times This plugin shows the latest load time of each plugin (QGIS startup, plugin installation,...). It does not give you information about the speed of plugins 

when they are used. This plugin was created by Michel Stuyts (https://stuyts.xyz). License: GPL-3.0

Plugin Reloader Reloads a chosen plugin in one click

This tool is only useful for Python Plugin Developers!

POI Exporter  Export CSV or GPX Points of Interest (POI). This plugin creates Points of Interest (POI) from a vector points layer. It supports Garmin CSV and GPX 

output formats. It allows the user to select a category column to be used to create separate files containing points from that category. The user can 

also select columns to be used for the POI name and description. The plugin can be found in "Vector->GPS->POI Exporter"

Point sampling 

tool 

Samples polygon attributes and raster values from multiple layers at specified sampling points. The Point Sampling Tool Plugin collects polygon 

attributes and raster values from multiple layers at specified sampling points. You need a point layer with locations of sampling points and at least one 

polygon or raster layer to probe values from. The plugin creates a new point layer with locations given by the sampling points and attributes taken 

from all the underlying polygons or/and raster cells. Please use Control and Shift keys in order to select multiple columns and bands. Note this tool is 

not compatible with mulitipoint sources, unless each multipoint contains exactly one point. Using multipoint samples that contain more points in 

multipoints may produce unreliable results.

PosiView PosiView tracks multiple mobile objects and vehicles and displays their position on the canvas

Track multiple objects and vehicles and display them as shapes and points on the canvas

PostTelemac Post Treatment for Telemac (and Anuga , HECRAS 2D as experimental). Post treatment of open Telemac results (and Anuga , HECRAS 2D as 

experimental). Requires matplotlib, shapely, numpy, scipy, networkx and ffmpeg libraries.

Potential Slope 

Failure 

This plugin maps potential slope failures in cohesive soils. This plugin maps potential slope failures in cohesive soils by making use of a raster-based 

shadowcasting algorithm. The method is explained in detail in Lindberg, Olvmo and Bergdahl (2011). 

(http://www.sciencedirect.com/science/article/pii/S0266352X11000693)

Processing (BF) Spatial data processing framework for QGIS

Profile tool Plots terrain profile. This tool plots profile lines from raster layers or point vector layer with elevation field. Supports multiple lines as well as graph 

export to svg, pdf, png or csv file. Supports 3D polyline export to dxf.



Projestions Projestions (projection + suggestions) for your active map layer or project using the EPSG area of use data. Select which geometry to send to the API 

for projestions, then the top suggestions are displayed. Select one of the suggested projections to set your project's projection.

PS Time Series 

Viewer 

Computation and visualization of time series of speed for Permanent Scatterers derived from satellite interferometry

QBan(o) QBAN(O) permet de géolocaliser vos adresses issues d'un fichier excel ou CSV. Il se sert de la base BAN (Base Adresse Nationale). Le fichier des 

adresses doit être ouvert dans Qgis. L'adresse doit être contenue dans une seule colonne (numero, rue, code postal, ville). Une fois la géolocalisation 

effectuée, une colonne "score" permet de connaitre la fiabilité de l'adresse, 1 étant la meilleure note (à partir de 0,5, la localisation est fiable).

Qchainage This plugin takes line features and creates a new layer of points in provided distances on top of this Lines. Optionally you can set the startpoint 

(distance from the start of the line) and the endpoint (stop before reaching the end of the line) and automatically label the new points with the 

distances. QChainage is either separating the selected (or all) Line-Features intoparts, or linear referencing after a chosen distance. All along the whole 

Feature or between selectable start and endpoint.
QConsolidate3 QConsolidate3 is a modified version of QConsolidate (https://github.com/alexbruy/qconsolidate) and OQ-Consolidate (https://github.com/gem/oq-

consolidate), that copies raster layers and converts vector layers to GeoPackage or ESRI ShapeFile, creates a project if it does not exist yet, allows to 

give a customized (validated) name to the consolidated project, allows to store all the project files in a zip file

Qesg Sanitary Sewage System Networks DesignUsed Libraries:-Qt matplotlib-ezdxf (Embedded) from Manfred Moitzi

QGIS Cloud Plugin Publish maps on qgiscloud.com. QGIS Cloud is your powerful Web-GIS platform for publishing maps, data and services on the internet. Create and edit 

professional maps with all the capabilities from QGIS. With only a few short mouse-clicks you can share your work on qgiscloud.com with the public.

QGIS GML 

Application 

Schema Toolbox

Consumption and use of GML complex features like INSPIRE harmonised data (vector), GeoSciML within QGIS

This plugins allows to import Complex Features streams in QGIS either through a native XML mode or through a conversion to a relational database 

model.

Qgis2threejs 3D visualization powered by WebGL technology and three.js JavaScript library. This plugin visualizes DEM data and vector data, in 3D on web browsers. 

You can build various kinds of 3D objects with simple settings panels and view them in web view of exporter. If you want to share them in web, you 

can generate files to publish them to web in simple procedure. In addition, you can save the 3D model in glTF format for 3DCG or 3D printing

qgis2web (BF) Export to an OpenLayers/Leaflet webmap. qgis2web generates a web map from your current QGIS project, either as OpenLayers or Leaflet. It 

replicates as many aspects of the project as it can, including layers, styles (including categorized and graduated), and extent. No server-side software 

required.

QgsProject 

Generator

Creates QGIS Projects from Interlis files

QNEAT3 QGIS Network Analysis Toolbox 3. The QNEAT3 (short for Qgis Network Analysis Toolbox 3) Plugin aims to provide sophisticated QGIS Processing-

Toolbox algorithms in the field of network analysis. QNEAT3 is integrated in the QGIS3 Processing Framework. It offers algorithms that range from 

simple shortest path solving to more complex tasks like Iso-Area (aka service areas, accessibility polygons) and OD-Matrix (Origin-Destination-Matrix) 

computation. The usage of some Iso-Area algorithms require the installation of the matplotlib python library from OSGeo4W (see algorithm and help 

page for more information).



Qpackage Qpackage is a tool to save both your QGIS project and data contained in the project to a new directory. It allows to convert any GIS vector format 

towards the .shp only. You may also apply a new projection.

QRealTime This plugin connects you to Aggregate Server and do autoupdation of data to and from aggregate. This software is designed and developed in IIRS for 

online data collection. Form designing to data compilation every step is automated in a way that everything can be done inside GIS environment

Quick Attribution Define the attributes for a layer first and then digitize a number of geometries with all the same attributes.

QuickCRS (BF) A QGIS plugin to set the CRS of the current project to your favourite CRS and (for QGIS 2.x) enable OTF project reprojection with just one click. It's 

very easy to set your default CRS in the Plugin Settings Menu. One click to enable your favourite CRS (OTF). This plugin was created by Michel Stuyts 

(https://stuyts.xyz). License: GPL-3.0

QuickMap 

Services

Collection of easy to add basemaps. Convenient list of services + search for finding datasets and basemaps. Please contribute new services via 

http://qms.nextgis.com! Built by NextGIS.

Quick OSM (Vector) Quick OSM allows you to download OSM data thanks to the Overpass API. You can also open local OSM or PBF files. A special parser, on top of 

OGR, is used to let you see all OSM keys available. Execute customs Overpass queries in QGIS to get OSM data.

QuickPrint (BF) The QuickPrint Plugin for QGIS3. The QuickPrint plug-in provides a simple way to quickly create a pdf from the map as shown in the map pane. The 

map is not just a screenshot, but a real map with a title, subtitle, scalebar, date, attribution and remarks. In this way you get a decent print without the 

hassle of setting up and using print templates. You can choose between A3 and A4 paper sizes and between portrait and landscape paper orientation.

QuickWKT Quick WKT/WKB viewer, this Qgis Plugin opens a dialog where the user can paste (E)WKT and WKB code and see it on the map. Pasted data are stored 

in a temporay (memory) layer and are completely lost when the user quits QGIS. Quick WKT/WKB is a plugin to easily show WKT/WKB data into QGIS. 

It also provides some utilities function and adds them to iface (see the about tab in the plugin's dialog for details).

Qweather Weather Information based on Yahoo API. This tool can be used to get weather using Yahoo Weather API. Get information about city, country, region, 

wind direction, wind speed, humidity, pressure, visibility, sunrise, sunset, lon, lat, temperature in celsius or fahreneit, date, and icon.

refFunctions New analytycal and spatial referencing functions for Field Calculator. Plugin that add custom user functions to Qgis Field calculator for referencing, 

analitically or spatially, between layers, For example retrieving a value from a layer using as a field value or a spatial condition (intersects, disjoint ....) 

as parameterv1.2 Code cleanup and dbvaluebyid() is unable to return $geometry issue fixed (courtesy of @SzieberthAdam 

https://github.com/SzieberthAdam) v1.3 New intersecting_geom_count and intersecting_geom_sum functions and migration code to QGIS3 (courtesy 

of @patricev https://github.com/patricev) v1.4 intersecting_geom_count/sum issue fixed (courtesy of @nantodevison 

https://github.com/enricofer/refFunctions/issues/11) v1.5 dbquery dbvalue dbnearest issues fixed

Remote Debug Connect a running QGIS plugin to a Python remote debugger

Remove empty 

layers from the 

map 

Cleans' the layer list widget (legend) by removing empty layers

RiverGIS RiverGIS is a QGIS plugin that helps you create HEC-RAS flow model.

The functionality is similar to that of HEC-GeoRAS. For data store and spatial operations it needs a PostGIS database.



RS&GIS Operates on raw satellite data (Landsat 1-8 & LISS) to produce standard outputs and user defined custom band outputs. Tool performs well defined 

algorithms on raw satellite data to produce popularly used outputs like > Land Surface Temperature (LST) > At. Satellite Brightness Temperature > 

Normalized Difference Vegetation Index (NDVI) > Normalized Difference Water Index (NDWI) > True Color Composite (TCC) > Flase Color Composite 

(FCC) > At Satellite Reflectance of available bands > At Satellite Radiance of available bands > Other user defined custom band outputs

ScriptRunner 3 Run scripts to automate QGIS tasks. Load and run scripts. NOTE: For Windows you need the pywin32 module. ScriptRunner attempts to install it for 

you if it isn't rpresent on your system (Windows only).

Select by 

relationship 

The plugin allows to select records through tables based on relationships one-to-one or one-to-many specified inside a QGIS project.<br>The plugin 

button will appear inside QGIS database menu. Anything in 3 steps:<br>1.Charge in a QGIS project your layers;<br>2.Set up the relationships between 

your layers inside the QGIS project properties;<br>3.Click on selectFromRelations button (or run its from QGIS toolbar Database->Select From Relation -

> Allow selections by relationship.<br><br>Now you can select records between many related tables.<br>You can see an example in this videotutorial 

by Salvatore Fiandaca: <a href="https://www.youtube.com/watch?v=4lXRnsMO-qI">link</a><br>The plugin started by an original thread posted by 

Salvatore Fiandaca and developed by Andrea Borruso and Salvatore Larosa: <a href="http://osgeo-org.1560.x6.nabble.com/QGIS-select-in-join-tabella-

in-relazione-td5317093.html">Original thread</a><br>A first post by Andrea Borruso: <a href="https://medium.com/ tantotanto/qgis-selezionare- 

geometrie-da-una-tabella-di-attributi-correlata-bea37747a7e2"> link</a><br>The original python macro by Salvatore Larosa: <a 

href="https://gist.github.com/slarosa/653e6d759cf0d82c2a2 4dcc499b094e0">link</a><br>A videotutorial by Salvatore Fiandaca where it's showed 

the use of python macro by Salvatore Larosa: <a href="https://www.youtube.com/watch?v=PRDftcPWNg8">link</a><br>An other videotutorial by 

Salvatore Fiandaca for testing the macro python code embedded inside selectFromRelations plugin: <a 

href="https://www.youtube.com/watch?v=4lXRnsMO-qI">link</a>
Select Within Centroid within, point of surface within, pole of inaccessibility within, percentage within, and mostly within selection. Works best with lines and 

polygons, but should work with other geometries as well. Centroid within point of surface within, pole of inaccessibility within, and mostly within 

selection. Centroid not guaranteed to be within the original geometry, while the other two centroid selection types are. Pole of inaccessibility is done 

using the polylabel algorithm: https://github.com/mapbox/polylabel as implemented in the QGIS core code. Works best with lines and polygons, but 

should work with other geometries as well.

Semi-Automatic 

Classification 

Plugin 

Plugin that allows for the supervised classification of remote sensing images, providing tools for the download, the preprocessing and postprocessing 

of images. Developed by Luca Congedo, the Semi-Automatic Classification Plugin (SCP) allows for the supervised classification of remote sensing 

images, providing tools for the download, the preprocessing and postprocessing of images. Search and download is available for ASTER, Landsat, 

MODIS, Sentinel-2, and Sentinel-3 images. Several algorithms are available for the land cover classification. This plugin requires the installation of 

GDAL, OGR, Numpy, SciPy, and Matplotlib. For more information please visit https://fromgistors.blogspot.com.
SentinelHub SentinelHub plugin enables users to harness power of Sentinel Hub services directly from QGIS. SentinelHub plugin transforms any layer created in 

Sentinel Hub Configuration Utility into QGIS layer. It allows exploration, customization and image download. An instance ID for Sentinel Hub services is 

required (http://www.sentinel-hub.com/). Trial (http://www.sentinel-hub.com/create_account) and free accounts are available 

(https://medium.com/sentinel-hub/sentinel-hub-at-the-eo-cloud-free-accounts-for-r-d-projects-eccb3e3d0659 and https://medium.com/sentinel-

hub/sentinel-hub-free-accounts-within-esa-business-applications-b0046c0595f0)



Shape Tools (Vector) Shape Tools features geodesic shapes and tools. Create ellipse, line of bearing, pie wedge, polygon, star, ellipse rose, hypocyloid, polyfoil, 

epicycloid, and heart shapes. "XY to Line" tool, densify lines and polygons along geodesic paths, geodesic measure tool, and digitize points at an 

azimuth & distance. Shape Tools features geodesic shapes and tools. "Create Shapes" processes a point vector layer to create ellipses, pie wedges, 

lines of bearing, polygons, stars, ellipse roses, hypocyloids, polyfoils, epicycloids, and hearts based on the table's fields and other parameters. "XY to 

Line" uses pairs of coordinates from each record to create geodesic lines. "Geodesic Shape Densifier" creates geodesic lines and polygons by adding 

additional vertices along geodesic paths within the shape. "Geodesic Measure Tool" measures distances using the WGS 84 ellipsoid and includes the 

bearing or heading between points. It will even saves the measurements as a layer. "Azimuth, Distance Digitizer" digitizes points based on a clicked 

point, an azimuth and distance or creates a geodesic line from a clicked point to an azimuth and distance. Shape Tools is installed in the Vector menu.

Socrata Download maps from Socrata-powered data portals. This is a simple plugin built to facilitate GIS sharing from Socrata sites. It is added to the web 

menu, as it is pulling from web datasets. This is not a Socrata product.

Spanish Inspire 

Catastral 

Downloader 

Descarga de cartografía catastral según Inspire. Plugin de QGIS para la descarga de datos catastrales de parcelas, edificios y direcciones de España. La 

descarga usa el servicio ATOM según la Directiva Inspire.  

f='http://www.catastro.minhap.gob.es/webinspire/index.html'>http://www.catastro.minhap.gob.es /webinspire/index.html</a></p><p>QGIS Plugin 

for the download of cadastral data of parcels, buildings and addresses of Spain. The download uses the ATOM service according to the Inspire 

Directive. href='http://www.catastro.minhap.gob.es/webinspire/index_eng.html'>http://www.catastro.minhap.gob.es/webinspire/ 

index_eng.html</a></p>

Split Features On 

Steroids 

Split features showing areas on each side allowing the edition of the cutting line vertices. Split one or more polygon/multipolygon features showing the 

resulting areas on each side of the cutting line. Adjust the vertices of the cutting line before splitting.

Spreadsheet 

Layers 

(BF) Load layers from spreadsheet files (*.ods, *.xls, *.xlsx). This plugin adds a "Add spreadsheet layer" entry in "Layer" / "Add new Layer" menu and a 

corresponding button in the "Layers" toolbar. These two links open the same dialog to load a layer from a spreadsheet file (*.ods, *.xls, *.xlsx) with 

some options (use header at first line, ignore some rows and optionally load geometry from x and y fields). When this dialog is accepted, it creates a 

new GDAL VRT file in same folder as the source data file and layer name, expanded with a .vrt suffix which is loaded into QGIS using OGR VRT driver. 

When reusing the same file twice, the dialog loads its values from the existing .vrt file. No need to install additional dependencies.

SPZ Builder Sanitary protection zone builder<br />Построение санитарно-защитных зон. <p>This plugin builds a sanitary protection zone based on the wind rose 

and the normative value.</p><p>Плагин предназначен для расчета и построения санитарно-защитных зон с учетом розы ветров.</p>

SQUAD Tool v3 Spatial Quality and Anomalies Diagnosis. The Spatial Quality and Anomalies Diagnosis (SQUAD) tool checks for six anomalies that are based on 

common errors in point-location data sets. This information can be used to prioritize the type and extent of investigation needed for records that may 

have problems. The anomalies that can be checked are: 1. Missing coordinates 2. Truncated coordinates (lack of adequate precision) 3. Duplicate 

coordinates for distinct records 4. Duplicate key attributes (two identical names, but plotting in different locations) 5. Coordinate not located exactly 

where it would be expected (but falling within two kilometers of a border) 6. Coordinate not located anywhere near where expected

SRTM 

Downloader 

(BF) Downloads SRTM Tiles from NASA Server

Plugin for download of SRTM Tiles from NASA



Standard 

Deviational 

Ellipse 

Create a standard deviational ellipse for a set of points. A standard deviational ellipse is produced according to two methods, with variations. The 

default method is the on presented by Robert Yuill (1971). This method does not correct for degrees of freedom. The Yuill method does not give a 

radius equal to the standard distance deviation for a random point distribution (to achieve this, the SDs should be multiplied by sqrt(2), as explained in 

the CrimeStat documentation). The plugin also offers the CrimeStat / aspace method, where there are corrections for degrees of freedom and with 

sqrt(2). A polygon vector layer with the standard deviational ellipse is produced, containing the attributes: meanx, meany, majorsd, minorsd, 

majorangle, directoind and eccentrici as explained in the documentation. The majorangle is counter-clockwise relative to the first axis. An attribute for 

weighting can be selected. There are no external library dependencies.
Stereonet Displays a geologic stereonet of selected data. Displays a geologic stereonet of selected geologic structure data. Data needs to be loaded into QGIS via 

"Delimited Text Layer." A stereonet will be plotted if there is a column labeled "Strike" or "DDR" and "Dip" (case doesn't matter). Poles of the 

structures are plotted on an equal area stereonet with a modified Kamb method contouring.

Street View (BF) Streetview allows you to open a web page with the Google Street View that highlights the part you have identified with two points (the base and 

target points) The target point is identified by dragging the base point.

Swiss Locator A locator filter for Swiss Geoportal (geo.admin.ch)

Search for locations, WMS layers of features in the whole Map Geo Admin catalog

Temporal/Spectr

al Profile Tool 

Plots profile from raster bands. Based on Profile Tool. A QGIS plugin for interactive plotting of temporal or spectral information stored in multi-band 

rasters. Based on Profile tool plugin. After installation and activation the plugin can be accessed either from main menu (under Plugins > Profile Tool > 

Temporal/Spectral Profile) or from an icon on the taskbar. This plugin is part of the Water Observation Information System (WOIS) developed under 

the TIGER-NET project funded by the European Space Agency as part of the long-term TIGER initiative aiming at promoting the use of Earth 

Observation (EO) for improved Integrated Water Resources Management (IWRM) in Africa. Copyright (C) 2014 TIGER-NET (www.tiger-net.org)

Tempus Plugin to interact with a Tempus instance. Tempus is a framework for multimodal route planning

TimeManager Create animations visualizing spatio-temporal data. TimeManager adds time controls to QGIS. Using these time controls, you can animate vector 

features based on a time attribute. There is also an experimental raster layer support and support for interpolation beween point geometries. You can 

create animations directly in the map window and export image series.

TomBio tools FSC QGIS Plugin for biological recorders. This is a plugin for QGIS desktop GIS which is aimed primarily at biological recorders. It streamlines many of 

the tasks commonly required from GIS by biological recorders including viewing NBN maps (via the NBN WMS), displaying biological records from CSV 

files, working with UK OS grid references and registering raster map images from the internet. Although originally designed for use in the the UK, 

enhancements have been made to improved utility in any geographical context.

TUFLOW A collection of utilities for TUFLOW modelling in QGIS. Includes visualisation of results / inputs Editing tools Styling tools

Value Tool Display in a table or plot the values from the visible raster layers at the current mouse position

Display raster layer values at current mouse position

Vector Tiles 

Reader

Vector tiles reader which supports server connections, MBTiles file and other sources. Reads vector tiles according to Mapbox Vector Tiles 

specification as layers in a group. Sources can be an internet server, from an MBTiles file or from a directory. This Python plugin uses prebuild C++ 

binaries for performance reasons. The plugin has connections already configured for the following providers: - OpenMapTiles.com - Mapcat.com

VectorFieldCalc Calculation of vector field parameters. This plugin calculates vector field parameters (e.g., magnitude, divergence, curl) and pathlines, given two rasters 

representing x- and y- velocities



Verificador de 

geometria 

Verificar erros em geometrias

Verificador de 

Topologia 

Plugin para encontrar erros topológicos em camadas vectoriais

Video Uav 

Tracker 

Replay a video in sync with a gps track displayed on the map (3d OPTIONS with 'panda3d' module installed)

see README file in repository for instructions and details

Virtual Raster 

Builder 

(BF) A QGIS Plugin to create GDAL Virtual Raster TIFF (VRT) files by drag and drop. The VRT Builder is a plugin to create GDAL Virtual Raster (VRT) files 

by drag and drop. It helps to create new images by stacking or mosaicing of source image bands, as well as to describe band- and spatial subsets. The 

VRT Builder is developed at Geographic Institute of Humboldt-Universität zu Berlin within the EnMAP-Box project under contract of the German 

Research Centre for Geosciences (GFZ). The EnMAP-Box project is part of the EnMAP Core Science Team activities (www.enmap.org), funded by the 

German Aerospace Center (DLR) and granted by the Federal Ministry of Economic Affairs and Energy (BMWi, grant no. 50EE1529). 

VoGIS-ProfilTool Create profiles from DHMs using vector geometries or a digitized line.

web2qgis Load a webmap directly into QGIS

Attempts to parse a remote webpage to import a webmap into a QGIS project

WKT Bulk Loader A plugin to bulk load WKT files. Give this plugin a directory and it will load all the *.wkt files in it

WNT Open 

Source 3 

A toolbox for water utility providers for QGIS 3. Water Network Toolbox (WNT) is an application for the documentation and management of water 

distribution systems. It offers fundamental functions for an orderly and effective operation of water networks.

ZEB Toolbox Toolbox for data of road monitoring and assessment in Germany (ZEB). The data of road monitoring and assessment in Germany are stored in a 

specific XML-schema, which cannot be read by different GI-systems. This plugin enables QGIS to extract the spatial information from the XML-files 

called Georohdaten and Rasterrohdaten and display them as temporary layers (directly in memory). Just ZEB-files of the type "Rohdaten[...]Geo" can 

be displayed in QGIS.

ZoomRC Zoom to a Spanish Cadastre Reference

ZoomToBelgium A button to zoom to any of the Belgian Municipalities or districts. Een knop om naar 1 van de Belgische steden, gemeenten of districten te zoomen. Un 

bouton pour zoomer sur une des communes ou districts belges. This plugin adds a button to your toolbar in QGIS to zoom to a selected Belgian 

municipality or district.



Notas

Novo

Novo



Abra uma caixa por baixo dos layers onde ficam as coordenadas do ponto em que se cliclou no mapa. Pode-se 

gravar para cilpboard





Carregar, importar, transferir, carregar para o GPS, converter ficheiros do GPS 

Menos interessante do que parecia









O icon são 2 folhas. Clica-se neste e depois no ponto do mapa de que queremos saber a lat - long









Vai para o Menu Processamento



Int. Permite criar imagens dos layers que queremos.



Permite ter o Google Earth

Fazer um print em pdf do layer que se quer.





Cria shapes com várias formas

Ao clicar num ponto do mapa abre-se o Google map dessa zona. Ex. clicar na Adega



Para ver a vinha, edifícios, etc. Ao girar vê-se em perspetiva



Imp. p/ criar os índeces de vegetação ~ ao NDVI. Ao fazer o save cria outra camada que fica no projeto; a 1ª 

perde-se.



Módulos

Outros
Icons

Texto

(BF)- Barra de ferramentas; Menus; 

Add spreadsheet layer (BF) Para abrir o excel

Search QMS panel (BF) Google, Google Normal, Google Satellite ( + int)

QuickMapServices (BF) Landsat (>), MapSurfer.NET (>), Nasa (>), OSM ((>) standard)), Outros. (O OSM é o + int.)

Criar nova camada GPX , mas (BF) Cria nova camada GPX (waypoints, routes e tracks) 

Nova camada temporária (BF) Cria Nova camada shapefile, Nova camada spatialite, Nova camada geopackage, Nova camada temporária.  

Nova camada shapefile (BF) Cria Nova camada shapefile, Nova camada spatialite, Nova camada geopackage, Nova camada temporária.  

Adicionar camada WFS (BF) Adicionar camada WFS, Adicionar camada Arcgis Feauture Server. Web Feature Service (WFS)

Adicionad camada WCS (BF) Adicionad camada WCS, Adicionad camada Arcgis Feauture Server. Web Coverage Service (WCS)

Adicionar camada ArcGis 

MapServer
(BF) Adicionar camada ArcGis MapServe, Adicionar camada WMS / WMTS. Web Map Service (WMS)

Adicionar camada PostGIS
(BF) Adicionar camada PostGIS, Adicionar camada espacial MSSQL,  Adicionar camada espacial DB2,  Adicionar camada 

espacial Oracle

Adicionar / Editar camada 

Virtual
(BF) Adicionar / Editar camada Virtua, Adicionar Editar WMS / WMTS

Adicionar camada SpatiaLite (BF) Adicionar camada SpatiaLit, Adicionar WMS / WMTS

Adicionar camada de texto 

delimitado
(BF) Adicionar camada de texto delimi, Adicionar camada de WMS / WMTS

Adicionar camada Raster (BF) Importar imagens geo do Google

Adicionar camada vetorial (BF) Cria Nova camada shapefile, Adicionar camada spatialite, Adicionar camada geopackage, Nova camada temporária.

Geodesic measure tool (BF) Cria Nova camada shapefile, Geodesic measure spatialite, Geodesic measure geopackage, Nova camada temporária.

Geodesic shape densifier (BF) Cria Nova camada shapefile, Geodesic shape spatialite, Geodesic shape geopackage, Nova camada temporária.



XY to line (BF) XY to line, XY to Arcgis Feauture Server

Create shapes (BF) Create shapes, área r ângulo

Abrir o gestor da fonte de 

dados
(BF) Abrir o gestor da fonte de dados, Abrir o gestor da fonte WMS / WMTS

Abrir camada Geopackage (BF)

Abri gestor de fonte de dados (BF) Abri gestor de fonte de dado, Abri gestor de fonte WMS / WMTS

Novo (BF)

Abrir (BF)

Guardar (BF)

Nova camada shapefile (BF) Cria Nova camada shapefile, Nova camada spatialite, Nova camada geopackage, Nova camada temporária.

Nova camada Spatialite (BF)

Guardar como (BF) Guardar como, área u ângulo

Novo layout de impressão (BF) Novo layout de impressã, Novo layout WMS / WMTS

Mostrar o gestor de layout (BF) Mostrar o gestor de layou, Mostrar o gestor WMS / WMTS

Mover mapa (BF) Mover mapa, área o ângulo

Ajustar mapa à seleção (BF) Ajustar mapa à seleçã, Ajustar mapa WMS / WMTS

Aproximar (BF)

Afastar (BF)

Aproximar à resolução natural (BF) Aproximar à resolução natura, Aproximar à WMS / WMTS



Ver tudo (BF) Ver tudo, área e ângulo

Aproximar à seleção (BF) Cria Nova camada shapefile, Aproximar à spatialite, Aproximar à geopackage, Nova camada temporária.

Aproximar à camada (BF) Cria Nova camada shapefile, Aproximar à spatialite, Aproximar à geopackage, Nova camada temporária.

Última vista (BF) Última vista, área l ângulo

Próxima vista (BF) Próxima vista, área r ângulo

Nova vista de mapa (BF) Nova vista de map, Nova vista WMS / WMTS

Novo marcador (BF) Novo marcador, área o ângulo

Atualizar (BF)

Highlith Pinned Labels and 

Diagrams 
(BF) Highlith Pinned Labels and Diagram, Highlith Pinned Labels WMS / WMTS

Ligação com base de dados 

eVis
(BF) Ligação com base de dados eVi, Ligação com base de WMS / WMTS

Ferramenta de evento ID eVis (BF) Ferramenta de evento ID eVi, Ferramenta de evento WMS / WMTS

Pesquisa de evento eVis (BF) Pesquisa de evento eVi, Pesquisa de WMS / WMTS

Gestor BD (BF)

MetaSearch (BF)

Cosola Phyton (BF) Cosola Phyton, área h ângulo

Contour (BF)

Limpar elementos de todas as 

camadas
(BF) Limpar elementos de todas as camadas. Limpar elementos de todas WMS / WMTS

Mostrar sumário estatístico (BF) Cria Nova camada shapefile, Mostrar sumário spatialite, Mostrar sumário geopackage, Nova camada temporária.



Medir linha (BF) Medir linha, área e ângulo

Dicas de mapa (BF) Cria Nova camada shapefile, Dicas de spatialite, Dicas de geopackage, Nova camada temporária.

Anotação de texto (BF) Anotação de texto, formulário, HTML, SVG e mover anotação

Click to open street google 

view
(BF) Click to open street google view, Click to open street WMS / WMTS

Point sample tools (BF) Cria Nova camada shapefile, Point sample spatialite, Point sample geopackage, Nova camada temporária.

Street view (BF) Street view, área / ângulo

Virtual Raster Builder (Raster) Virtual Raster Builder, Virtual Raster espacial MSSQL,  Virtual Raster espacial DB2,  Virtual Raster espacial Oracle

Conteúdos de ajuda (BF) Cria Nova camada shapefile, Conteúdos de spatialite, Conteúdos de geopackage, Nova camada temporária.

Captura de coordenadas (BF) Cria Nova camada shapefile, Captura de spatialite, Captura de geopackage, Nova camada temporária.

Ferramentas GPS (BF) Permite carregar os ficheiros GPX (route_points, routes, tracks, points e tracks)

Verificador de topologia (??) Cria Nova camada shapefile, Verificador de spatialite, Verificador de geopackage, Nova camada temporária.

FS3 - FieldStat3 (BF) Ánalise estatística de dados (elementar)

Georeferencer (BF) Georeferenciar as imagens do Google

Set favourire CRS (BF) Set favourire CRS, Set favourire Arcgis Feauture Server. Definir o tipo de coordenadas

QuickOSM (BF) OSM- Open Street Map

JOSM Remote (BF) JOSM Remote, área e ângulo

GPX Segment Importer (BF) GPX Segment Importer, GPX Segment Arcgis Feauture Server

Edições atuais (BF) Edições atuais, área / ângulo. 



Alternar edição (BF) Alternar edição, área / ângulo

Guardar as edições da camada (BF) Guardar as edições da camad, Guardar as edições WMS / WMTS

Add (point, line polygon) 

feature
(BF) Add (point, line polygon) featur, Add point line WMS / WMTS

Mover elemento (BF) Mover elemento, área / ângulo

Ferramenta de vértices (BF) Cria Nova camada shapefile, Ferramenta de spatialite, Ferramenta de geopackage, Nova camada temporária.

Apagar seleção (BF) Apagar seleção, área / ângulo

Cortar elementos (BF) Cortar elementos, área / ângulo

Copiar elementos (BF) Copiar elementos, área / ângulo

Colar elementos (BF) Colar elementos, área / ângulo

Anular (BF)

Refazer (BF)

Opções de etiqueta da camada (BF) Opções de etiqueta da camada, Opções de etiqueta WMS / WMTS

Opções da camada diagrama (BF) Opções da camada diagram, Opções da WMS / WMTS

Hight pinned labels and 

diagrams
(BF) Hight pinned labels and diagrams, Hight pinned labels WMS / WMTS

Pin / unpin labels and diagrams (BF) Pin / unpin labels and diagram, Pin unpin labels WMS / WMTS

Mostrar / ocultar etiquetas e 

diagramas
(BF) Mostrar / ocultar etiquetas e di, Mostrar ocultar etiquetas WMS / WMTS

Mover labels e diagramas (BF) Mover labels e diagrama, Mover labels WMS / WMTS

Rodar etiquetas (BF) Rodar etiquetas, área o ângulo



Alterar etiqueta (BF) Alterar etiqueta, área l ângulo

Identificar elementos (BF) Identificar elementos, área d ângulo

Duplicate feature (BF) Duplicate feature and digitise

Selecionar elementos por 

polígonos

(BF) Selecionar elemento, Selecionar elementos por polígonos, Selecionar elementos por delimitação livre, Selecionar 

elementos por raio

Select features by value
(BF) Selecionar elementos por atributos, selecionar elementos por expressão, selecionar todos os elementos, Inverter 

seleção da camada

Abrir tabela de atributos (BF) Identificar os valores dos fatores

Abrir calculadora de campos (BF) Abrir calculadora de campo, Abrir calculadora WMS / WMTS

Ativar ferramentas de 

digitalização avançada
(BF) Ativar ferramentas de digitalização, Ativar ferramentas de WMS / WMTS

Rodar elemento (BF) Rodar elemento, área o ângulo

Simplificar elemento (BF) Simplificar elemento, área i ângulo

Adicionar anel (BF) Adicionar anel, área d ângulo

Adicionar parte (BF) Adicionar parte, área d ângulo

Preencher anel (BF) Preencher anel, área r ângulo

Apagar anel (BF) Apagar anel, área p ângulo

Apagar parte (BF) Apagar parte, área p ângulo

Redesenhar elementos (BF) Redesenhar elementos, área e ângulo

Curva de afastamento (BF) Cria Nova camada shapefile, Curva de spatialite, Curva de geopackage, Nova camada temporária.

Dividir elementos (BF) Dividir elementos, área i ângulo

Expansão cumulativa do corte 

usando a extensão atual
(BF) Expansão cumulativa do corte usa, Expansão cumulativa do corte usando a WMS / WMTS



Expansão cumulativa do corte 

usando a tot. da extensão
(BF) Expansão cumulativa do corte usa, Expansão cumulativa do corte usando a tot WMS / WMTS

Expansão do histograma local (BF) Expansão do histograma loca, Expansão do WMS / WMTS

Expandir histograma ao total 

da camada
(BF) Expandir histograma ao total da , Expandir histograma ao total WMS / WMTS

Aumentar brilho (BF) Aumentar brilho, área / ângulo

Diminuir brilho (BF) Diminuir brilho, área / ângulo

Aumentar contraste (BF) Aumentar contraste, área / ângulo

Diminuir contraste (BF) Diminuir contraste, área / ângulo

Juntar atributos dos elementos 

selecionados
(BF) Juntar atributos dos elementos, Juntar atributos dos WMS / WMTS

Rodar símbolos de pontos (BF) Rodar símbolos de ponto, Rodar símbolos WMS / WMTS



Notas









Para mover os vértices dos polígonos



Mto imp.


